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Analyza sekvencnich dat za ucelem pripravit data k ndsledné fylogenetické analyze zahrnuje napriklad
ndsledujici kroky:

l. prohlédnuti sekvenci, zjisténi kvality (FinchTV)
Il. kontrola totoznosti sekvence (BLAST)
[l vytvoreni contigu (SeqMan), uloZeni ve formatu FASTA

V. vytvoreni alignmentu (MAFFT nebo Clustal)

V. editace alignmentu, price s datasetem (BioEdit, MEGA)

VI. prace s FASTA formatem (FaBox)

VII. konvertovani format( CLUSTAL, FASTA, NEXUS sequential (FORCON)

VIIL. automatické kddovani indelll (SegState)

IX. analyza sekvenci ve Splitstree (neighbour-network), detekce rekombinantt

X. testovani model( evoluce DNA (jModeltest, PartitionFinder, Python)

XI. testovani fylogenetické struktury v datech (TreePuzle, PAUP, Excel)

XIl. testovani substitucni saturace sekvenci (MEGA, HyPhy, Perl, Sitestripper, PAUP)

l. Sekvence (soubory *.abl) si lze prohlédnout napf. vprogramu FinchTV
(http://www.geospiza.com/Products/finchtv.shtml). Sekvence by méla byt Citelnd od cca 30-50 bazi
do cca 550-650 bazi (nékdy i mnohem dale). Pokud nevidime jednoznacné peaky pro jednotlivé baze,
je néco v neporadku. Pouze kvalitni sekvence mizeme déle analyzovat. V programu FinchTV mizZeme
sekvence editovat, tj. ménit ,base calling”, mazat i vkladat baze. Program dale umoznuje vyhledavat
v sekvencich, export do formatu FASTA, tisk chromatogramu a také prohlizeni primdrnich dat (raw
data). V ptipadé nejasnych sekvencich je vidy nutné se na né podivat (View = Raw Data).

Troubleshooting (viz také napf. http://www.nucleics.com/DNA sequencing support/DNA-
sequencing-troubleshooting.html). Pro odhaleni problému je nutné si uvédomit, jaky PCR produkt
jsme sekvenovali (cpDNA, nrDNA, nDNA, PCR po klonovani) a zjistit, zda je problém v PCR, sekvenacni
reakci, nebo v podstaté amplifikovaného Useku (napt. ,,multiple-copy” vs. ,,low-copy” Useky).

Sekvence je dlouhd jen nékolik (desitek) bazi.

- byly osekvenovany zifejmé jen primery, chyba pravdépodobné v sekvenacni reakci (nizka
koncentrace vstupniho PCR produktu, Spatné primery apod.). Pokud byl sekvenovan PCR produkt po
klonovani, je pravdépodobné, Ze klonovaci vektor neobsahuje poZadovany insert a byla
osekvenovana jen Cast vektoru (Spatny vybér kolonie, chyba v ligaci apod.).

Prvnich nékolik desitek bazi (20-100) sekvence je nekvalitnich (chaoticky se prekryvajici piky), zbytek
sekvence je dobre Citelny.



- kontaminace sekvenacni reakce kratSimi produkty, mlze byt i problém na sekvendtoru. Pokud
problém pretrvdvd i po zopakovani reakce, je dobré zamyslet se nad optimalizaci PCR, ptipadné
designem novych primer(.

Sekvence je cdstecné dobre Citelnd a cdstecné se jednotlivé piky prekryvaji a tvofi tzv. dvojpiky;
pfipadné je celd sekvence dobre Citelnd, jen misty se objevuji dvojpiky.

- pravdépodobné intra-individualni variabilita amplifikovaného useku. Pokud byl sekvenovan usek
nNDNA nebo nrDNA, Ize tuto variabilitu vysvétlit jako alelickou variabilitu nebo jako pfitomnost vice
paralogd daného Useku v daném genomu. Re$enim tohoto problému je napf. klonovani daného PCR
produktu, nebo design primer( specifickych pro konkrétni paralog. Pokud byl sekvenovan usek
cpDNA, jedna se nejspiSe o kontaminaci a je tfeba analyzu opakovat, pfipadné optimalizovat PCR.

Sekvence je nejprve dobre Citelnd a v urcitém misté se najednou stdvad necitelnou, piky se pfekryvaji

- mlzZe to byt opét intra-individudlni variabilita (byly amplifikovany useky lisici se inzerci/deleci =
indel). Pokud se posun stane za Usekem tvofenym vétSim mnoZstvim stejnych bazi (napf. poly-T
usek), jedna se jen o chybu vzniklou sklouznutim polymerazy. Dlllezité je zkontrolovat (i) forward vs.
reverzni sekvenci (pokud je pouze jeden indel resp. sklouzla polymeraza, mélo by jit celou sekvenci
snadno rekonstruovat) a (ii) zda se sekvencéni motiv opakuje i v prekryvajicich se picich, jen je jedna
varianta o 1-x (podle délky indelu) posunuta.

Blizko pocdtku je nékolik bazi prekryto extrémné vysokym a Sirokym pikem (tzv. blob)

- sekvenacni reakce byla nedostatecné nebo Spatné precisténd, velmi cCasto vsak lze sekvenci pod
,blobem" rekonstruovat

. Identitu sekvenci je tfeba zkontrolovat pomoci on-line aplikace BLAST (Basic Local Alignment
Search Tool, http://blast.ncbi.nlm.nih.gov/Blast.cgi), zejména pokud se jedna o nové testovany
marker, ¢i organismus. Ve FinchTV (nebo jiném prohlize¢i sekvenci) zkopirujeme citelnou ¢ast
sekvence. Otevieme webové stranky BLASTu a vybereme program ,nucleotide blast”. Do volného
okénka v panelu , Enter query sequence” vloZzime zkopirovanou cast sekvence ve fasta formatu (viz
nize). Prohleddvame vétsinou pouze databazi , Others” (zaskrtneme v panelu , Choose search set”).
V panelu , Program selection” poté zadame citlivost hledani na ,Somewhat similar sequences
(blastn)” a spustime hledani (tlacitkem ,BLAST”). Vysledkem hledani je seznam nejpodobnéjsich
sekvenci z prohleddvané databdaze vcetné grafického znazornéni, jak nalezené sekvence pasuji na nasi
sekvenci. Pokud nalezené sekvence pochazeji ze stejného nebo blizce pfibuzného druhu a odpovidaji
useku, ktery mél byt amplifikovan, mizeme postoupit k dalSimu kroku.

Troubleshooting



Vysledkem hleddni je sekvence z velmi vzddleného organismu (napf. bakterie, ¢lovék, houba apod.)
a/nebo nalezeny usek neodpovidd useku, ktery mél byt amplifikovdn.

- problém vPCR (kontaminace, malo specifické ¢i velmi degenerované primery preferenéné
amplifikujici napf. symbionta studovaného organismu apod.).

- pro hledanou sekvenci nebyla v databazi nalezena Zadna podobna sekvence. Mlze se stat zejména
tehdy, pokud je sekvenovdn méné obvykly a vysoce variabilni Usek nDNA (napf. intron néjakého
genu) u nemodelového organismu. VétsSinou vsak lze v sekvenci nalézt alespon cast useku, ktera
odpovida exonu genu, nebo konzervativnimu useku, kde byly umistény primery.

- pokud byla sekvence ziskana po klonovani, je moiné, Ze malo specifické primery amplifikuji
preferencné usek bakteridlniho genomu. Pokud pti amplifikaci DNA z kolonii pouzivdme univerzalni
primery (napf. M13F a M13R), mlZe se stat, Zze amplifikujeme jen bakteridlni vektor. Ktémto
situacim dochazi zejména v pfipadech, kdy byl Spatné zaligovdn pozadovany PCR produkt.

Il Pro ziskani sekvence v celé délce amplifikovaného produktu, je potreba spojit forward a
reverse sekvence (vytvofit tzv. contig). V pfipadé méné kvalitnich sekvenci Ize editovat evidentné
Spatny ,base calling” (pfeklad peakl na jednotlivé baze). To je moZné udélat napf. v programu
SeqMan (soucast baliku DNASTAR Lasergene Core Suite, http://www.dnastar.com/t-sub-products-
lasergene-segmanpro.aspx).

e File > New > Add Sequences

e vlozit forward i reverse sekvenci od jednoho vzorku (dvojklikem nebo oznadit + ,,Add“)

e Assemble, potom dvojklik na Contig 1 (pokud jsou sekvence v porddku a dostatecné se
prekryvaji, mél by se vytvofit pouze jeden contig)

e zkontrolovat, zda je forward sekvence zleva doprava, pokud ne, tak Contig = Complement
Contig

e rozbalit vSechny sekvence kliknutim na trojuhelnicek vlevo od nazvu

e prekontrolovat ,base calling” viadku Translate (consensus sekvence), pfipadné jasné chyby
zeditovat (prepsat)

e oznacit mysi a zkopirovat (Ctrl+C) horni radek (Translate), pfipadné jeho ¢ast

e vlozit do textového souboru (napf. do pozndmkového bloku), nazev sekvence uvést ve formatu
FASTA

e toto provedeme pro vSechny sekvence a textovy soubor ulozime s koncovkou *.fas

FASTA format — jednoduchy a asi nejbézinéjsi format pti praci se sekvencemi (v nazvech sekvenci
nepouzivdme mezery, ale podtrZitka , “ nebo svislé cary“|“). Priklad:

>jmeno_sekvence 1|lokus 1
TGCGCTTAATTCCGGTGCCAAAGTCTTCATGGTCGATGCATCCTTAG

> jmeno_sekvence 2|lokus 2
AATGCTCTTAATTCCGGTGCCATGGTCGATGCTTCCTTAGAACATCATT

> jmeno_sekvence 3]|lokus_ 3



TTCCGGTGCCATGGTCGATGCTTCCTTAGAACATCATT

Alternativné lze contig samoziejm¢ vytvaiet i v jinych programech (napi. Geneious,
http://www.geneious.com nebo SeqAssem, http://www.sequentix.de/software segassem.php)
nebo s vyuzitim webové verze programu CAP3 (http://pbil.univ-lyonl.fr/cap3.php).

Troubleshooting

Program nedokdze spojit pozZadované sekvence.

- snizena kvalita jedné ze sekvenci nebo obou sekvenci - program nenajde piekryv.

- forward a reverse sekvence se prekryvaji nedostateéné - bézné v ptipadé, kdy je sekvenaéni
reakce predCasné ukoncena kvili useku mnoha stejnych nukleotidd (tzv. poly-T,-A,-C,-G
useky) u forward i reverse primeru. Takové sekvence lze spojit manudlné — pokud jsou
forward i reverse sekvence v poradku az k poly-tseku uprostied, jediné co nevime, je pocet
opakovani v tomto useku (nahradime ho nékolika ,,N*).

- forward a reverse sekvence se nepiekryvaji vilbec — je amplifikovan pfili§ dlouhy usek, nebo
je pritomno vice poly usekti. Pro sekvenaci PCR produktu je tfeba pouzit 1 tzv. vnitini primery
(mohou byt dostupné, nebo je nutné je noveé designovat na zakladé znamych sekvenci). Poté
se spojuje do contigu vice nez dve¢, tj. nékolik forward a reverse sekvenci.

V. Dale je potifeba vytvofit tzv. alignment, tj. sefadit pod sebe homologni baze (positional
homology). Existuje mnoho algoritmd, jak alignment vytvofit — mezi nejznaméjsi patfi Clustal
(progresivni metoda), PRRN (iterativni metoda) a MAFFT (kombinace progresivni a iterativni metody).
S algoritmy lze experimentovat bud' lokadlné (instalaci pfislusnych programi) nebo vyuZit webové
aplikace:

MAFFT (webova aplikace: http://mafft.cbrc.jp/alignment/server)

e do okna,/nput” nacteme nebo vloZzime soubor obsahujici sekvence ve fasta formatu.

e vpanelu ,Advanced settings“ mlzieme nastavit konkrétnéjsi strategii a/nebo parametry pro
tvorbu alignmentu (napf. pokud analyzujeme blizce ptibuzné sekvence, tj. tfeba v ramci druhu nebo
z blizce pfibuznych druhd, je vhodné v sekci ,Parameters” nastavit ,Scoring matrix for nucleotide
sequences: 1PAM/k=2").

o tlacitkem ,Submit” spustime analyzu

e vystup analyzy je v MAFFT formdtu, odkazem nahofe zménime na FASTA format, tento
alignment zkopirujeme a uloZime ho do textového souboru s pfiponou *.fas (FASTA format s gapy)

e vlevé Casti okna s vystupem jsou grafy scervenymi (pfipadné i modrymi) pfimkami. Za
pfitomnosti ¢ervené i modré primky graf naznacuje, Ze ve vstupnich sekvencich jsou ¢asti sekvenci
v reverse-complement orientaci oproti ostatnim.

e  program lze také stdhnout a pouZivat lokalné bez pfistupu k internetu
(http://mafft.cbrc.jp/alignment/software/windows without cygwin.html)

ClustalX (webova aplikace: http://www.ebi.ac.uk/Tools/msa/clustalw?)

e STEP 1 -vloZeni sekvence ve FASTA formatu, zvoleni DNA jako vstupnich dat

e STEP 2 — nastaveni parametr( parového alignmentu (pokud mame pouze dvé sekvence)

e  STEP 3 — nastaveni parametrl mnohondasobného alignmentu véetné vystupniho formatu (napfr.
NEXUS nebo FASTA)



e  STEP 4 —spusténi analyzy
Program lze také stahnout a pouzivat lokédlné (http://www.clustal.org/download/current)

e  File > Load Sequences

e  Alignment > Do Complete Alignment

e vytvoreny alignment je automaticky uloZen do souboru s koncovkou *.aln (format CLUSTAL),
pripadné dalsi formaty je tfeba zvolit pod Alignment = Output Format Options

Pozn. 1: Alignmenty vytvotfené pomoci Clustal algoritmu vSak mohou byt hor$i a mohou
vyzadovat rozsahlejsi manualni upravy (zejména pokud jsou sekvence vice rozdilné nebo je
v alignmentu vétsi mnoZzstvi indell).

Pozn. 2: TentyZ algoritmus (zvany ClustalW, tj. program bez grafického rozhrani) je obsazen i pfimo
v programu BioEdit (viz bod V). Vtomto programu si oznacime vSechny sekvence (Ctrl+A),
zmackneme Accessory Application = ClustalW Multiple alignment - Run ClustalW. Vysledny

alignment se otevie rovnou v novém BioEditovém okné.

Mezi dalsi servery, které umoznuji délat alignment patfi napf. GenomeNet
(http://www.genome.jp/tools/clustalw — Ize pfepinat mezi Clustal, MAFFT a PRRN).

Troubleshooting
Neéktera sekvence je extremné odlisnd, neni mozné ji alignovat s ostatnimi.
- jedna se o reverse complement (prohozeni forward a reverse primeru) — mozné automaticky zménit

napf. v programu BioEdit (oznalit pfisluSnou sekvenci klepnutim na jeji ndzev a pak prikaz
Ctrl+Shift+R). K jednoduché zaméné sekvence na reverse complement sekvenci lze také pouzit
program RC (http://www.famd.me.uk/AGL/RC.zip)

- jedna se o sekvenci jiného Useku / jiného organismu (viz bod 1)

V. Automaticky vytvoreny alignment bychom méli pfinejmensim zkontrolovat a pfipadné
manualné upravit bud pfimo v textovém editoru (napt. v poznamkovém bloku) nebo vyuzit vyhod
programu BioEdit (http://www.mbio.ncsu.edu/BioEdit/bioedit.html)

Jako vstupni format pro BioEdit Ize pouzit format CLUSTAL nebo alignované sekvence ve
FASTA formatu.

e File > Open

e vybrat soubor s koncovkou *. aln nebo *.fas (napf. vystup z analyzy MAFFT)

e vrozbalovacim okné ,Mode" nastavime rezim ,Edit”, ktery umozniuje manipulaci se sekvencemi
(pfepisovani, mazani bazi — lze prepinat mezi mody Insert a Overwrite v druhém rozbalovacim okné)

e  pro zvyraznéni rozdilll v sekvencich Ize vyuZit Siroké skaly moZnosti podbarveni (napf. dle miry
variability sekvenci apod.) pomoci ikon v hlavni nabidkové listé a rozbalovaciho okna ,Shade
treshold" nahote
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e editace alignmentu je intuitivni — prepisovani bazi, kopirovnani Usekl, vkladani gap( (pomoci
pravého tlacitka)

e alignment mGzZeme uloZit jako editovany FASTA soubor *.fas, nebo vybrat jiny format z nabidky
dle potieby

e pomoci File > Export > Sequence alignment mzeme sekvence uloZit i jako soubor NEXUS (s
koncovkou *.nex, pouze typ interleave), ktery lze pfimo pouZit pro analyzu v programu PAUP (viz bod
X), MrBayes (http://mrbayes.csit.fsu.edu) nebo SplitsTree (viz bod 1X). Pozor, BioEdit trpi fadou
drobnych chyb, napf. ukladani NEXUS soubor(i mizZe byt problém pokud je nazev souboru ¢i jeho
cesty pfilis slozity — v takovém pfripadé je tfeba soubor nazvat jednoduseji.

e uzZitecné zkratky: Ctrl+A (oznaceni vSech sekvenci), Ctrl+Del (smazani oznacené sekvence),
Ctrl+Shift+R (vytvoreni reverse complement)

Mtize se také hodit...

e pokud je editovidna sekvence obsahujici kédujici i nekddujici iseky genl, mlze byt uZiteéné
takové useky odlisit, napt. pomoci velkych (pro kddujici) a malych pismen (pro nekodujici DNA).
Oznatte mysi pozadovany Usek a vhlavnim menu vyberte Sequences -> Manipulations >
UPPERCASE/lowercase

e pokud jsou editovany pouze kédujici sekvence genu (napf. exony) ve spravném ¢tecim ramci, lze
vyuzit prekladac zDNA do sekvenci aminokyselin (Ctr+T) a odhadnout tak (ne)pfitomnost
pseudogend.

Alternativné Ize pouzit jednoduchy editor PhyDE (http://www.phyde.de), kde je tfeba mit alignment
ve formatu FASTA nebo NEXUS sequential.

e  File > Open

e vybrat soubor s koncovkou *.fas

e  otevie se okno s alignhmentem a barevné oznacenymi bazemi

e  pfipadné presuny bazi nebo jejich bloki miZeme udélat pomoci mysi — oznacime pri sou¢asném
stisku levého tlacitka, klikneme pravym, preneseme na jiné misto, opét klikneme pravym. Méody
editace jsou Align (lze pouze posouvat gapy) nebo Edit (pozor! zde Ize sekvence i editovat).

e  File > Export as... 2 NEXUS (nebo FASTA, dle libosti...)

VL. FaBox — manipulace se sekvencemi ve formatu FASTA
(http://users-birc.au.dk/biopv/php/fabox/)

e pomoci tohoto webu lze manipulovat se sekvencemi ve FASTA formatu (pracovat s hlavickami,
ofezavat a spojovat alignmenty, formatovat pro dalsi programy)

e Ize také extrahovat pouze variabilni pozice alignmentu (,,Show variable sites only")

e volba , Create TCS input file from fasta (fasta2tcs)” vytvori spravné formatovany soubor pro
analyzu v programu TCS

e volba ,Create MrBayes input file from fasta (fasta2mrbayes)” vytvofi NEXUS soubor vcéetné
sekce s prikazy pro program MrBayes (v zavéru souboru; zacina , begin mrbayes;”“ a konci ,end;”).
Smazanim této sekce ziskdme standardni NEXUS soubor pouzitelny i do jinych aplikaci (napf. PAUP
ad.).




VII. Razné formaty sekvenci (CLUSTAL, FASTA, NEXUS ad.) mGzeme konvertovat pomoci riznych
webovych aplikaci, jako napf.
e Sequence conversion (http://sequenceconversion.bugaco.com/converter/biology/sequences)
e Format Converter v2.0.5
(http://hcv.lanl.gov/content/sequence/FORMAT CONVERSION/form.html)

Alternativou k webovym aplikacim je programu FORCON
(http://bioinformatics.psb.ugent.be/webtools/ForCon), ktery viak funguje pouze pod WinXP.

e Input format: CLUSTAL, Output format: FASTA, OK

e zmeénit typ souboru na ,vSechny”, otevrit soubor alignmentu (s koncovkou *.aln)
e  Cut-off after how many characters ? — napsat vice nez je pozic alignmentu

e uloZit s koncovkou *.fas

e Select All, OK

VIII. Pokud alignment obsahuje mezery (gaps), tedy inserce/delece (souhrnné indely), které
mohou byt fylogeneticky informativni, je potreba je okddovat jako zvldstni znaky. To Ize automaticky
provést napf. v programu SeqState (http://bioinfweb.info/Software/SeqState). Podrobnosti ohledné
zpUsobu kdédovani indelll Ize nalézt napf. v ¢lanku Muller (2006): Incorporating information from
length-mutational events into phylogenetic analysis. Molecular Phylogenetics and Evolution, 38, 667-
676.

e  File > Load NEXUS file (nebo Load FASTA file)

e vybrat soubor s koncovkou *.nex (nesmi byt v interleave, ale v sequential formatu, tj. vytvoreny
napf. v programu PhyDE nebo preformatovany pomoci webové sluzby, viz bod VII), resp. *.fas

e IndelCoder - simple indel coding (bliz$i informace o zplsobu kddovani viz zmifiovany ¢lanek)

e vygeneruje NEXUS soubor (interleave — k nazvu plvodniho souboru pfidd _mcic.nex) s pivodni
matici a pridanym kédovanim indeld, ktery lze pfimo pouZit pro analyzu napf. v programu PAUP

IX. (Pre-)analyza sekvenci v programu SplitsTree (http://www.splitstree.org/). Sestrojenim sité
napf. algoritmem neighbour-net Ize vizualizovat konfliktni signaly v datasetu. Diky tomu ji lze vyuzit
napf. pro detekci hybridnich jedinci nebo rekombinantnich sekvenci. Pozor, vyuZivaji se distanéni
metody (v zdkladnim nastaveni program navic pouZiva pouze nekorigované p-distance) — jedna se o
uzite€ného pomocnika, ale v analyze sekvencnich dat tento program neni plnohodnotnou ndhradou
parsimonickych nebo Bayesovskych pristup( tvorby fylogenetickych stromu.

e  vstupni format je NEXUS. File = Open (soubor s pfiponou *.nex), analyza probéhne automaticky
s defaultnim nastavenim (pro orientacni analyzu neni tfeba pfenastavovat).

ez vysledné sité je mozné nékteré sekvence vyrazovat (pravy klik mysi — Exclude selected taxa) —
zkoumame jak se méni topologie sité. Vyrazené sekvence je mozné opét vratit pres Data > Restore
All Taxa

e  Obrazky je mozné snadno exportovat, napf. do pdf: (File 2> Export Image).




X. Testovani modelli evoluce DNA. Vhodné zvoleny model evoluce DNA je klicovy pfi
vypoctech vérohodnosti topologii fylogenetickych stroml pomoci pravdépodobnostnich metod
(napf. Maximum likelihood nebo Bayesovska analyza).

Pfed vlastnim testovanim modeld, které nejlépe vystihuji evoluci DNA v nasich datech, je dobré zjistit
strukturu studovaného useku, tj. jakou ¢ast useku tvofi napr. koédujici sekvence, nekddujici sekvence
apod. Hranice téchto Usek(l odvozujeme proto, Ze kaZzdy z nich se potencidlné mohl vyvijet jinym
zpUsobem (jiné mutaéni rychlosti apod.) a mohl by byt charakterizovan jinym evolué¢nim modelem.
Informace o studovaném Useku nalezneme napf. pomoci on-line aplikace BLAST (viz vySe, odst. Il.),
kdy hleddme nejpodobnéjsi sekvenci k nami analyzované, kterd je anotovana (tedy je zde uvedena
struktura DNA Useku, viz. obr. niZe).

Zingiberaceas: Plagioscachys.
REFERENCE 1 (hases 1 to 2681)
AUTHORE  Rress, W.0., Pr
TITLE The phyl
(Zingiberaceas) : evidence fioe molecular dats
JOUBNAL  Am. J. Dot. US (100, leUZ-1686 [2002)
FUBMED 21005555
DEFERENCE 2 (bases 1 to 26E1)
RUTHORS §.3., Prince,L M. and ¥illinams, .3,
TITLE "t Eubmisaton
JOURNAL  Submatted (J1-JAN-ZUUZ) Systematic Diolody - Dotany, Umithsonian
Institution, National Museum of Matural History, Washington, D¢
20860, NSK
FEATURES Loeation/gualifices
P 1..2681

foryanism=*Playivstachys sp. LMP-Z00Z-1%
foryanelle="plastidichloruplast™
fwel_type=Tgsnomic DNA"
fdb_xref=Traxon:zUuuiat
frinaur_type=Tieats

yene <1..>2651

Sgene="maLk"
811..2358

Sgene=~matg"
foodon_start=l
Sreanal_table=11
Jproduct="maLura
Sprutein AANEIZ

fdb_xrer 1Z4BI4Y
Stranslation="HEELOGYLEEYRIRQOOFLYFLLFQEY LVF AYDNGLNSSIFYE
PINSLCYDNEFSSVLVERL LIRNY QRN YU IYSVND I YO IFVCHNNYF YFEFFSQILF
EGFAVIVETPFSLOL TSSLEER HNLOSSHETFPFLEDKLLELNYLSD TLIPYR
AHME TLVCHLCSWTGD ALSLALLOFLLEEYYHUNSL T TPHES TTVP SRINRRLFCFLY
HLYIYEYEFLLVFPCROSSFLRLISSGVLLERIHF TVEIEHLGVCRIFCORTLVIFED
PFIHYIRYOGEI ILGIRGTHF LHREVEYHLVNFWOTYFRFVIQPYRIDTRELSNYSFY
FLOYFESVOMHNSSMUINONLENSFLIDTL TRELOTRIP T TPLTRSLEKAQFCTVEGYD
TERP THTDLABCDT INRFGOTCRRLEHYHSGESKROSL Y RIKY TLRLSC ARTLARKKE

Pokud jsme potfebné informace zjistili, mlizeme dataset manualné rozdélit napf. na kddujici ¢ast a
nekddujici ¢ast, tj. vytvofit z jednoho fasta souboru dva a vice jinych fasta souborl (vhodné
oznacenych jako ,,....exon.fas“, ,,...intron.fas“ apod). Rozdéleni plvodniho souboru mizeme provést
napf. v programu BioEdit odstranénim nezadoucich ¢asti alignmentu. Ze vzniklych soubort vytvofime
format NEXUS, ktery pouZijeme pfi vlastnim testovani modeld.

Alternativnim zpUsobem, jak rozdélit plvodni dataset na jednotlivé Useky, je pripojit na konec
souboru NEXUS (nebo i do separatniho souboru) nékolik pfikaz, které definuji rozdéleni alignmentu
na tzv. partition. Zplsob definovani jednotlivych Usekd vidy radéji konzultujte s dokumentaci
k programu, pro ktery rozdéleny dataset potrebujete (napt. PAUP, MrBayes, PartitionFInder apod..),
mohou se totiz vice ¢i méné lisit. Prikladovy Nexus blok pro rozdéleni kédujicich sekvenci podle
pozice nukleotidd v tripletu pro ucely Baysovské analyzy viz nize.

begin mrbayes; # zacCatek nového nexus bloku (miZe byt nap¥. i “Begin sets;”)

outgroup 22;

charset CHS posl 1-957\3; # definice tGseku - kdédujici sekvence, prvni nukleotidy v tripletu
charset CHS pos2 = 2-957\3; # koédujici sekvence, druhé nukleotidy v tripletu

charset CHS pos3 = 3-957\3; # koédujici sekvence, tfeti nukleotidy v tripletu

partition Position = 3: CHS posl, CHS pos2, CHS pos3; # rozdéleni datasetu

end;

Testovani modelld pomoci jModeltest (http://code.google.com/p/imodeltest2/) pro naslednou
analyzu pomoci ML. Program jModeltest nepfijima datasety rozdélené pomoci partitions, takze je
nutné analyzovat dataset jako celek, pfipadné analyzovat separatné jednotlivé jeho ¢&asti (tj. zvlast
exony, zvlast introny apod...).

e  File > Load DNA alignment # vyberte soubor ve formatu Phylip nebo Nexus



e Analysis =2 Compute likelihood scores = nasatveni komplexity analyzy (od 3 do 88 model() —
pokud budeme data analyzovat déle pomoci ML, nastavime maximalni pocet modell (tj.
nastavime ,Number of substitution rates” = 11 a zaskrneme vSechna okénka v ,Base
frequencies” a ,Rate variation“. Ostatni miUZeme nechat jako default. Pokud budeme analyzovat
data pomoci programu MrBayes, staci nastavit komplexitu nizsi, nebot v programu lze nastavit
jen nékolik specifickych modelll. Pro testovani modell pro MrBayes lze vyuZit i specifického
programu MrModeltest, ktery testuje pravé jen modely, které Ize v této analyze poufzit.

e Analysis 2 Do AIC calculation = ponechame defaultni nastaveni a zaskrtneme , write *PAUP
block”

e  Program zobrazi vysledky porovnani jednotlivych model( a jejich likelihood scores (vérohodnosti
jednotlivych modell). V sekci ,AKAIKE INFORMATION CRITERION (AIC)” nalezneme
nejoptimalnéjsi model pro nase data vyhodnoceny podle kriteria AIC. NiZze zkopirujeme soubor
prikazl, kodujici pouZiti vybraného modelu pro nase data napt. pro analyzu ML, a vloZime je do
Nexus souboru s plivodnim alignmentem.

PAUP* Commands Block:

If you want to load the selected model and associated estimates in PAUP¥*,
attach the next block of commands after the data in your PAUP file:

[

Likelihood settings from best-fit model (HKY+G) selected by AIC

with jModeltest 0.1.1 on Thu Oct 17 13:26:26 CEST 2013]

BEGIN PAUP;

Lset base=(0.4010 0.2062 0.1059 0.2870) nst=2 tratio=3.3506 rates=gamma shape=0.4330 ncat=4
pinvar=0;

END;

Testovani modelll pomoci PartitionFinder (http://www.robertlanfear.com/partitionfinder/) pro
naslednou analyzu pomoci ML. Tato metoda ma oproti vyse zminénému jModeltestu vyhodu ve
schopnosti analyzovat jediny vstupni dataset, ktery mizZe byt rozdélen na nékolik Usekll pomoci
definice partitions. Program otestuje vSechny modely na vSech partitions a nasledné rozhodne, které
partition si zaslouzi specificky model, pfipadné, které partitions je mozné spojit apod. To je vyhodné
zejména v situaci, kdy chceme zjistit, jestli je vdaném uUsek( potfeba rozliSovat rychlost evoluce
nejen mezi kédujicimi a nekddujicimi Useky, ale i napf. v ramci kddujicich Usek( na jednotlivych
pozicich v tripletu. Takové rozdéleni alignmentu kondéi svice nez tfremi partitions a neni pfilis
praktické takové ¢lenéni délat manudlné. PartitionFinder je skript napsany v jazyce Python a pro jeho
pouziti je tfeba mit prostredi Python pfedem nainstalované (viz http://www.python.org/).

e  Vstupnimi soubory, které by mély byt uloZeny spolu v jedné sloZce, je alignment sekvenci ve
formaty Phylip a soubor ,partition_finder.cfg”, ve kterém je uveden nazev souboru obsahujiciho
data (*.phy), zadefinovano rozdéleni vztupniho datasetu na partition a specifikace vlastniho
testovani model(. Specifikace vlastni analyzy a editaci souboru *.cfg je dobré konzultovat
s dokumentaci k programu. Defaultni nastaveni ale mizZe vypadat napf. takto:

## ALIGNMENT FILE ##
alignment = test.phy;

## BRANCHLENGTHS: linked | unlinked ##
branchlengths = linked;

## MODELS OF EVOLUTION for PartitionFinder: all | raxml | mrbayes | beast | <list> ##
#4# for PartitionFinderProtein: all protein | <list> ##
models = all;



# MODEL SELECCTION: AIC | AICc | BIC #
model selection = BIC;

## DATA BLOCKS: see manual for how to define ##
[data blocks]

Genel posl = 1-1062\3;

Genel pos2 = 2-1062\3;

Genel pos3 = 3-1062\3;

#4# SCHEMES, search: all | greedy | rcluster | hcluster | user ##
[schemes]
search = greedy;

#user schemes go here if search=user. See manual for how to define.#

e Vlastni analyzu spustime pomoci prikazové radky, kterou pfivoldme ve Windows napf. pomoci
Start > Run 2 cmd

e Do prikazové radky vepiseme pftikaz se strukturou

python “<PartitionFinder.py>" “<inputFolderName>"

kde “<PartitionFinder.py>" predstavuje cestu ke skriptu PartitionFinder.py (m0zZe byt kdekoliv v
pocitaci) a “<inputFolderName>" predstavuje cestu ke sloZce se vstupnimi formaty (take
umisténymi kdekoliv). Obé cesty mizeme dostat do prikazové radky za prikaz “python” pouhym
pretazenim ze slozek kde jsou umistény.

e  Po skonceni analyzy se vytvoti v pracovni slozce nova slozka s ndzvem “analysis”. V této slozce
nas bude nejvice zajimat soubor “best _schemes.txt”, kde nalezneme informace o nejlepsi
varianté poskladani jednotlivych partitions a do skupin se spole¢nym evolu¢nim modelem.

ubset | Best Model | Subset Partitions| Subset Sites | Alignment

| F81+G | Genel_posl, Gene2_posl, Gene3 posl | 1-789\3, 790-1449\3, 1450-2208\3 | .....
F81+G Genel_pos2, Gene2_pos2, Gene3_pos2 | 2-789\3, 791-1449\3, 1451-2208\3 | .....

| |
| K80+G | Genel pos3 | 3-789\3 | .....
| |

S
1
2
3
4 TrN+G Gene2_pos3, Gene3_pos3 | 792-1449\3, 1452-2208\3 |

Scheme Description in PartitionFinder format
Scheme step 5 = (Genel posl, Gene2 posl, Gene3 posl) (Genel pos2, Gene2 pos2, Gene3 pos2)
(Genel pos3) (Gene2 pos3, Gene3 pos3);

e  Program vsak negeneruje jednotny blok pro Nexus soubor, ktery bychom mohli vloZit za nas
alignment. Je nutné si vytvofit blok vlastni se specifikacemi modeld pro jednotlivé skupiny
partitions.

XL. Testovani fylogenetické struktury v datech (TreePuzle, PAUP, Excel)
Pomoci téchto analyz zjistujeme, jaka je mira fylogenetické informace a Sumu v datech.
Likelihood mapping

e programy:
o Tree Puzzle: tree-puzzle-5.2-windows.zip

e zdrojové alignmenty (fylogeneze druh krasivkového rodu Micrasterias):
o SSU: Micrasterias_SSU.phy
o psaA: Micrasterias_psa.phy
o coxlll: Micrasterias_cox.phy
e instalace programu:
o odzipovat
o v adresafi ,src” pfejmenovat ,puzzle-windows-mingw-static.exe” na , puzzle.exe”
o nastaveni cesty k programu (program Ize pak poustét z jakékoli slozky):
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= kliknout pravou mysi na ,,mj pocita¢” — vybrat , vlastnosti“
= kliknout na ,,upfesnit nastaveni systému“
= na karté ,Uptesnit” kliknout na ,,Proménné prostredi...””
= v okné ,Systémové proménné vybrat , Path“, kliknout na ,Upravit...”
= na zacdtku radku ,,Hodnota proménné” pfidat cestu k programu Tree puzzle
(napt. C:\tree-puzzle\src;). Cesta musi koncit stfednikem!
= OK
v adresafi se zdrojovymi daty spustit program (napsat do prikazového radku , puzzle.exe”)
vybrat alignment (napf. ,Micrasterias_SSU.phy“)
nastavit analyzu: ,b“ — likelihood mapping, ostatni parametry nechat defaultné nastavené
nastavit analyzu: ,,m“ — vybrani spravného modelu evoluce. Program pracuje dobte s HKY
modelem. Pokud by ¢lovék chtél nastavit GTR model, pak se musi zadat jednotlivé substituc¢ni
rychlosti podle vystupu Model testu
spustit analyzu: ,y“
vystupy programu:
o outfile: zprava o priib&hu a vysledcich analyzy. Uplné dole je pak procentudlni
zastoupeni resolved a unresolved quartets
outdist: ML distance vsech dvojic sekvenci
outlm.eps: graficky vystup analyzy
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g statistika

programy:
o PAUP
o Excel ¢i obdobny tabulkovy program
zdrojové alignmenty (fylogeneze druh krasivkového rodu Micrasterias):
o SSU: Micrasterias_SSU.nex
o psaA: Micrasterias_psa.nex
o coxlll: Micrasterias_cox.nex
instalace programu PAUP:
o vizinstalaéni CD
o nastavit cestu k programu (viz vyse)
v adresafri se zdrojovymi daty spustit program PAUP (paup.exe)
nacdist alignment — nap¥. ,,exe Micrasterias_SSU.nex
generovat 1000 nahodnych strom{
o generatetrees random ntrees=10000;
o pscore/scorefile=ACT_exon_scores;
o end;
nakresleni histogramu v R:
o my_data<-read.table("ACT_exon_scores",header = TRUE)
o tree_lengths<-my_dataSLength
o hist(tree_lengths)
nakresleni histogramu v Excelu:
o vygenerované délky stromul importovat do Excelu (oddélovac: tabulator)
o nainstalovat doplnék Analytické nastroje: Soubor — MoZnosti — Dopliiky - Spravovat:
Doplriky aplikace Excel — Prejit... — zaskrtnout ,Analytické ndstroje” — OK
o Podle minimalni a maximalni hodnoty délek stromU vygenerovat sloupecek
s hranicemi tfid (napf. ¢isla 100, 120, 140, 160, 180, ...)
o Vytvoreni histogramu: Data — Analyza dat — Histogram — vybrat sloupecky s délkami
stromU a hranicemi gttid. Zaskrtnout: Vytvofit graf
vypocteni hodnoty g, v R
o nahrat package ,e1071“ — Install package...., Load package...
o skewness(tree_lengths)
vypocteni hodnoty g, v Excelu
o spocitat primér a smérodatnou é (T, - Ty
i

odchylku délek strom =

where n is the number of trees of length
T and s is the standard deviation of tree
délkou lengths. For a perfectly symmetrical tree-
length distribution g, = 0, whereas a left-
skewed distribution has a g, < 0 and a
g1 = (suma mocnin)/(1000*(smérodatnd  right-skewed distribution has a g, > 0.

odchylka délek)*3)

o pro kaZzdou délku strom0 spocitat tieti
mocninu jejiho rozdilu s priimérnou

spocitat sumu vsech tfetich mocnin
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XIl. Testovani substitucni saturace sekvenci
Pomoci téchto analyz ur¢ujeme miru Sumu v datech zpUsobenou substitucni saturaci.

Saturacni krivky

e programy:
o PAUP
o Excel
e zdrojové alignmenty (fylogeneze tfidy Chrysophyceae — zlativky):
o rbclL - 1. pozice koddnu: chryso_rbcll.nex
o rbclL— 2. pozice koddnu: chryso_rbcl2.nex
o rbcL - 3. pozice koddnu: chryso_rbcl3.nex
e pro kazdy allignment vytvofit dva Nexus soubory, pro vypocet uncorrected a corrected
distanci. Na konec Nexus souborl pfipojit PAUP bloky:
o PAUP blok pro vypocet uncorrected distanci:
=  begin paup;
= dset distance=p;
= savedist format=onecolumn file=uncorrected_distances undefined=asterisk;
= end;
o PAUP blok pro vypocet corrected distanci (hodnoty ,, dset” uvedené kurzivou vybrat i
zadat podle vystupu z Model testu):
= begin paup;
= dset distance=JC/F81/HKY85/GTR rates=equal/gamma shape = 0.0000
pinvar = 0.0000;,
= savedist format=onecolumn file=corrected_distances undefined=asterisk;
= end;
e oba alignmenty otevfit a zanalyzovat v programu PAUP. Po kaZzdé analyze je nutné PAUP
zavrit, protoZe si pamatuje nastaveni modeld!
O paup ndzev_souboru
o vystupem analyzy je soubor obsahujici distance
e graf v Excelu: distance importovat do Excelu, vytvofit XY graf
e grafvR:
uncorrected<-read.table("uncorrected_distances", sep="\t")
uncorrected_dist<-subset(uncorrected, select=V3)
corrected<-read.table("corrected_distances", sep="\t")
corrected_dist<-subset(corrected, select=V3)
distances<-data.frame(corrected_dist,uncorrected_dist)
plot(distances, xlab="corrected distances", ylab="uncorrected distances")
abline(0, 1,col = "red")

O O O O O O
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Site stripping

e programy:

o HyPhy
o MEGA
o Perl

o SiteStripper
e zdrojové alignmenty (fylogeneze tfidy Chrysophyceae — zlativky):
o rbclL - 1. pozice koddnu: chryso_rbcll.fas
o rbclL - 2. pozice kodénu: chryso_rbcl2.fas
o rbclL— 3. pozice kodénu: chryso_rbcl3.fas
e instalace programu HyPhy:
o viz http://hyphy.org/w/index.php/Main Page
e instalace programu MEGA:

o viz http://www.megasoftware.net/

e instalace prostredi Perl (Active Perl):
viz http://www.activestate.com/activeperl

o nainstalovat program (v ramci instalace povolit pfidani cesty do PATH)
o spustit Perl Package Manager
o nainstalovat Bioperl ze stejného manageru — ndvod viz ,,GUI Installation” na

strance:http://www.bioperl.org/wiki/Installing Bioperl on Windows
= tj., nainstalovat jednotlivé repositories podle doporuc¢enych odazl pro Perl
5.10, nékteré z nich Ize najit v, Suggested”

® nainstalovat Bioperl
o v Perl Package Manager dale nainstalovat package ,Sort-Array” (stejné jako pfi
instalaci package Bioperl. Pokud se objevi hlaska ,Authorization denied”, pak
nainstalovat druhou nalezenou package stejného jména
e instalace programu SiteStripper:
o stahnout si package sitestripper.pl - viz
http://www.phycoweb.net/software/SiteStripper/index.html
e tvorba rychlého ML stromu v MEGA:
otevfit Fastaalignment v programu MEGA

o Data - Export alignment — MEGA Format
o otevfit MEGA alignment
o Phylogeny — Construct/Test Maximum LikelihoodTree:

= Test ofPhylogeny — none
= Substitution Model &RatesamongSites — vybrat podle Model Testu
=  Compute

o Po vypocteni stromu: File — Export CurrentTree (Newick)

e spocteni substituénich rychlosti v programy HyPhy
o spustit HyPhy, Standart analysis = SubstitutionRates (SiteRates.bf)
o vybrat alignment, vybrat optimalni substitu¢ni model (podle Model Testu), Model
Options: ,,Global”
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o vybrat ML strom vypocteny v programu MEGA
o po vypoctu program vyzve k uloZeni substitu¢nich rychlosti
sitestripping
o zkopirovat Perl skript , sitestripper.pl” do adresare s alignmentem a souborem
substitucnich rychlosti
o spustit Perl skript: ,perl sitestripper.pl -a -r -f -0“, kde
= -a=fastaalighment sekvenci
= -r=soubor se substitu¢nimi rychlostmi
= -f=procento ponechanych bazi
= -0 =vysledny alighment
napft.: ,perl sitestripper.pl -a chryso_rbcl1.fas -r rbcllrates.txt -f .90 -o rbcllout.nex”
procento ponechanych bazi je idedlné uréeno na zdkladé saturacnich krivek. To lze
zobrazit a spocitat v R takto:
= corrected_sorted<-sort(corrected_distSV3, decreasing = FALSE)
= strip<-which.min(abs(corrected_sorted - 0.6))
= stripping<-strip/(length(corrected_sorted)/100)
= stripping
= abline(v=0.6, col = "blue")
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